Introduction
Unit Title:
Introduction to Personal Computers and Windows

Grade Level:
Adult Education

Target Group:
Mainstream class with integrated ELL students

Source of Written Reading Materials:
Russo, Anita. 2003. Introduction to Personal Computers and Windows. Wallingford, CT: Discovery Training Services, LLC. (Note: As owner of Discovery Training Services, I develop the curriculum and write the manuals.)

Source of Lessons:
Anita Russo

Goals:
1. I want my students to know the main components of a computer system.
2. I want my students to know how to use a mouse.
3. I want my students to know the parts of a window and what they are used for.
4. I want my students to know how to access software programs.
5. I want my students to know where files are stored on a computer.
TABLE OF CONTENTS

UNIT GOALS .................................................................................................................. 1

LESSON 1

NARRATIVE .................................................................................................................. 2
OBJECTIVES .................................................................................................................. 4
FUNCTIONAL-NOTIONAL CHART .................................................................................. 5
PLAN ............................................................................................................................... 7

LESSON 2

NARRATIVE .................................................................................................................. 19
OBJECTIVES .................................................................................................................. 20
FUNCTIONAL-NOTIONAL CHART .................................................................................. 21
PLAN ............................................................................................................................... 22

LESSON 3

NARRATIVE .................................................................................................................. 29
OBJECTIVES .................................................................................................................. 30
FUNCTIONAL-NOTIONAL CHART .................................................................................. 31
PLAN ............................................................................................................................... 33

LESSON 4

NARRATIVE .................................................................................................................. 43
OBJECTIVES .................................................................................................................. 44
FUNCTIONAL-NOTIONAL CHART .................................................................................. 45
PLAN ............................................................................................................................... 47

APPENDIX

ORIGINAL LESSON PLANS ......................................................................................... 61
GRAMMAR AND FUNCTIONS CHECKLISTS ................................................................ 65
SHELTERED ELL STRATEGIES CHECKLIST .............................................................. 66

FINAL REFLECTION .................................................................................................... ADDENDUM
ORIGINAL TEXT ......................................................................................................... END OF UNIT
<table>
<thead>
<tr>
<th>Knowledge</th>
<th>ESL LANGUAGE</th>
<th>LANGUAGE</th>
<th>CONTENT</th>
<th>LEARNING STRATEGIES</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. Vocabulary</td>
<td></td>
<td>1. The main components of a computer and what they do</td>
<td>Experiment and explore - don’t be afraid to click and “mouse around”!</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. How to use a mouse</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. The parts of a window and their uses</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. How to access software programs</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5. Where/how files are stored on a computer</td>
<td></td>
</tr>
<tr>
<td>Skills</td>
<td>1. Recognize and use the language of computers.</td>
<td></td>
<td>1. Name the major components of a computer system.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2. Write a short description of what each major computer component does</td>
<td></td>
<td>2. Describe the main function of the major components of a computer system.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4. Describe how to use the various parts of a window.</td>
<td></td>
<td>4. Explain what the various parts of a window do.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5. Produce a sequenced description of how to access a computer program</td>
<td></td>
<td>5. Open multiple programs.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6. Label a graphic presentation of a computer’s filing system.</td>
<td></td>
<td>6. Explain the computer’s file storage system.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7. Write a paragraph using a computer about the benefits of computers.</td>
<td></td>
<td>7. Create a document and save it.</td>
<td></td>
</tr>
<tr>
<td>Attitudes / Awareness</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Feel comfortable using a computer</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Appreciate what computers can do</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Lesson 1
Narrative - Lesson Plan 1

The only way in which my new plan resembles my original plan is the order in which I introduce the topics. Other than that, it is not recognizable. I did a complete rewriting of it to better explain to a new teacher how to accommodate ELL’s while presenting the lesson. Consequently, my original succinct plan of one page expanded to five pages, excluding the added materials.

My objectives this time were written in accordance with the objectives of the unit. I also expanded the objectives to include three levels: 1) Early Production ELLs, 2) Speech Emergence ELLs, and 3) Intermediate ELLs and Mainstream students.

Right at the beginning of the lesson, during the initiation, I recognized ways to start accommodating ELLs by simplifying questions for them during their introductions.

The first lesson in this unit is heavily laden with vocabulary, so the use of the Word Wall is a fantastic way to help students (ELLs and mainstream) with the new words. Words will be added to the Word Wall throughout the unit, but most heavily in the first lesson.

Another modification I made is the use of the Functional – Notional chart to help ELLs with the new vocabulary. In this plan I have instructed the teacher to use the formula expressions in the F-N chart whenever possible.

I included several graphics for the teacher and the students. One is a sample diagram (The CPU Graphic) that I draw on the board when I am defining the internal workings of a computer. I put this in for the teacher although she may want to give it to students. I also added a T-List for the students to summarize the parts of a computer system. There is a labeled graphic at the bottom of it. Another graphic that I think will be extremely helpful is a Sequence Chart. I used it to describe the steps of turning on the computer and logging on.

It is amazing the effect that is made with just some simple little changes to the way we do things. I saw this clearly when I made two very simple changes to the student manual. My student manuals always include wide margins for note taking. So it was very easy for me to
put some text in the margin of a couple of pages to help the student extract the most
important information. When you look at the original and rewritten pages side by side, the
benefit to the margin notations is striking.

Unfortunately in the first lesson, there is not much opportunity for students to interact, except
at the very end of the lesson when they are working in pairs to review the material. There
will be more opportunities for interaction in subsequent lessons.

I’m looking forward to using the modified plan.

AR
Modified Lesson Plan 1: Getting Started with Computers (90 min.)

Objectives:

1) To define the major components of a computer system:
   - All will name the components
   - Most will briefly tell what each component does
   - Some will describe in detail the functions and options of each component

2) To learn the steps to turn on and log on to a computer
   - All will demonstrate the steps
   - Most will demonstrate and tell another the steps
   - Some will describe the process in detail

3) To identify the objects on the Windows desktop
   - All will name the objects
   - Most will briefly tell what each object does
   - Some will describe in detail the functions of each object

4) To learn to do three things with a mouse: select items, open items and move items
   - All will demonstrate the three mouse actions
   - Most will demonstrate and briefly tell how to complete the three mouse actions

Bring to Class

Student Manuals
Disks and CD’s
Old CPU “carcass”
Old hard drive
Old memory chips
### Functional – Notional Chart, Lesson 1

<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>SITUATION</th>
<th>FORMULAIC EXPRESSIONS</th>
<th>GRAMMAR</th>
<th>VOCABULARY</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME</td>
<td>Parts of a computer system</td>
<td>A computer has a __________________________.</td>
<td>Nouns</td>
<td>CPU or System Unit</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Monitor or Screen</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Keyboard</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Mouse</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Software or Programs</td>
</tr>
<tr>
<td>LIST</td>
<td>3 major components of the CPU</td>
<td>The CPU has ______________________________.</td>
<td></td>
<td>Processor or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Microprocessor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>RAM or Memory</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Drives or Storage</td>
</tr>
<tr>
<td>DEFINE</td>
<td>Computer Storage</td>
<td>Files are saved on __________________________.</td>
<td></td>
<td>Files</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Disks or Floppies or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Floppy Disks</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Hard Drives</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>CD’s</td>
</tr>
<tr>
<td>RECOGNIZE</td>
<td>Keyboard</td>
<td>The __________________ key is used to log on to a</td>
<td></td>
<td>Ctrl</td>
</tr>
<tr>
<td></td>
<td></td>
<td>computer.</td>
<td></td>
<td>Alt</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To log on to the computer, press ________ and ________</td>
<td></td>
<td>Delete</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and ________ at the same time.</td>
<td></td>
<td>Tab</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DEMONSTRATE</td>
<td>Accessing the computer</td>
<td>To turn on the computer, use the ________</td>
<td></td>
<td>Power Switch</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>On</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Off</td>
</tr>
<tr>
<td>IDENTIFY</td>
<td>Windows Desktop Objects</td>
<td></td>
<td></td>
<td>Desktop</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Icons</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Taskbar</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Start Button</td>
</tr>
</tbody>
</table>

Created by Anita Russo

FLA 518

July, 2005
<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>SITUATION</th>
<th>FORMULAIC EXPRESSIONS</th>
<th>GRAMMAR</th>
<th>VOCABULARY</th>
</tr>
</thead>
<tbody>
<tr>
<td>USE</td>
<td>The Mouse</td>
<td>Use the mouse to ____</td>
<td>Verbs</td>
<td>Select</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Infinitives</td>
<td>Move</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Open</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Click</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Drag</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Double-click</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Right-click</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Right</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Left</td>
</tr>
</tbody>
</table>
Lesson 1

Initiation (10 min.)

Ask students (show of hands) how many are somewhat afraid of computers. Use body language for ELLs to show fear.

Tell the students that we use computers all the time without thinking about it. For example, ask how many use a microwave; how many use a VCR; how many use an ATM. All of these are computers. Tell them that if they can master a VCR, they can master a personal computer!

Ask students to introduce themselves and tell what experience they have had (if any) with computers. For example, do they have a computer at home? Do they use it? Do they use a computer at work?

Modification for Early Production and Speech Emergence ELLs

- What is your name?
- Do you have a computer?
- Have you used a computer?

Review the day’s objectives (already written on whiteboard):

- to learn the main parts of a computer
- to learn to turn it on and log on
- to use the Desktop
- to use the mouse

Distribute the Student Manuals and tell the class to put them aside for now.
Lesson 1 (Cont.)

A. Computer Terminology. (30 min.)

The teacher has a computer system at the front of the class and all students are sitting at a computer which is off. The teacher also has various “pieces and parts” of a computer system.

The teacher will name the major components as she points to them. As each word is introduced, she will add it to the “word wall”, (a modification for Early Production and Speech Emergence ELLs), sheets of flip chart paper hung around the room. The teacher will start with the most common words and also supply synonyms if appropriate: monitor (or screen), keyboard, mouse, CPU (or system unit).

Modification for Early Production and Speech Emergence ELLs

As the words are introduced, and the teacher writes them on the word wall, the teacher will slow her pace and repeat the sentence, “A computer has a monitor”, “A computer has a keyboard,” etc. (See F-N Chart, pages 5 - 6)

The teacher will then define the 3 major components (parts) of the CPU, adding more words to the word wall. In addition the teacher will draw a CPU on the whiteboard, (See sample on page 12) adding and defining one component at a time: RAM (or memory), processor (or microprocessor) and drives (or storage). Use a “brain and heart” analogy to define memory and the processor. Use the “file cabinet” analogy to define storage of files. The teacher will also pass around the old parts so students can see and hold them.

Modification for Early Production and Speech Emergence ELLs

As the words are introduced, and the teacher will again slow her pace and repeat the sentence, “The CPU has memory”, “The CPU has storage,” etc. (See F-N chart, pages 5 - 6.)

Introduce and define software. Use the “video and VCR” and “CD and CD player” analogies to define it. Windows is software, the first software everyone uses.
Review and summarize parts of a computer system.

**Modification for Early Production and Speech Emergence ELLs**

- Distribute and review *T-List graphic organizer* with words and meanings. (See page 13) Read aloud, pointing to each component.
- Refer class to pages 2 – 7 in their student manual for more detailed information. Point out summary information in margins. (See pages 14 and 15 for rewritten pages with summary information in the margins; pages 16 and 17 are the original pages in the text.)

**B. The Keyboard and Mouse (10 min.)**

In a **hands-on manipulative activity**, the instructor will direct the class to look at their keyboard and find the *Ctrl* keys, the *Alt* keys (2 of each) and the *Delete* key and the *Tab* key. These keys are needed to log on. These words will be added to the *word wall*.

**Modification for Early Production and Speech Emergence ELLs**

Repeat the pertinent expressions in the F-N chart:

- The *Alt* key is used to log on to a computer.
- The *Ctrl* key is used to log on to a computer.
- The *Delete* key is used to log on to a computer.

The teacher will have the class look at their mouse and will point out that there are 2 buttons, right and left. They will use only the left button for now. Add *right* and *left* to the word wall. The teacher will **model** how to hold the mouse to avoid an achy wrist.

The teacher directs the class to look at the front of the CPU and find the *Power Switch* to turn the computer on (1) and off (0). Add these words to the wall.
C. Logging On (10min.)

The teacher will outline the process on the whiteboard:

- Turn the computer on
- Press Ctrl and Alt and Delete at the same time
- Type your User Name (and press the Tab key)
- Type your Password (and press Enter)

The teacher will stress the importance of security and to never tell anyone your password.

Modification for Early Production and Speech Emergence ELLs

- Relate “password” to a PIN number or a combination lock.

Teacher will review again the steps to start a computer and log in.

Modification for Early Production and Speech Emergence ELLs

- Teacher will distribute and read the Sequence graphic organizer (See page 18)
- Teacher will refer students to page 8 in student manual for detailed information.

Hands on manipulative activity: Teacher will model the steps to turn on her computer and log on. (Teacher’s system is connected to a projector.) Then students will turn on their computers and log on with the assigned user names and passwords.

D. The Desktop (5 min.)

Teacher will add more words to the word wall:

- The first thing you see when you start a computer is the Desktop. The Desktop is Windows.
- The pictures are called icons; they represent programs (software) or tasks you do on a computer.
- The gray bar at the bottom of the screen is called the Taskbar; it keeps track of the software programs that you are using.
- Start button is on the left end of the Taskbar; it is used to start programs.
E. Using The Mouse – A Hands-on Manipulative Activity (15 min.)

- The teacher models selecting an item (icon): point to an item and click once with the left mouse button. The item is “selected” or “highlighted”. **Add new words to Word Wall.** Students will practice selecting items.
- Teacher models moving items: point to the item and press and hold the left mouse button while moving the mouse. Students will practice moving icons around on the Desktop.
- Teacher models opening items: point to an item and double-click. Students will practice opening items on the Desktop.

**Modification for Early Production and Speech Emergence ELLs**
Refer students to page 10 of the student manual and read the T-List aloud.

Closure (5 min.)

1) Summarize computer components (use the Word Wall). The teacher will model the sentence, A computer has __________, and ask individual students to fill in an answer.

   **Modification for Early Production ELLs:** These students will fill in one word.

   **Modification for Speech Emergence ELLs:** These students will repeat the whole sentence.

2) Summarize the log on procedure.

   **Modification for Early Production and Speech Emergence ELLs**
   In pairs, have each tell their partner the steps for starting and logging on to a computer. (They can use the task sequence graphic organizer.)

3) Summarize the mouse movements.

   **Modification for Early Production and Speech Emergence ELLs**
   In pairs, have each partner demonstrate to the other the 3 mouse moves: select, move and open.

Assignment: bring a computer advertisement to the next class. Look in the newspaper, junk mail, magazines, catalogs.
THE CPU GRAPHIC
Teacher will draw this on the board as she is defining the 3 major components of the CPU.

**Memory**: How “smart” the machine is; how much it is capable of holding in its head at one time.

**Processor**: It’s in control. Like the heart – it controls everything that comes in and everything that goes out.

**Drives**: They provide a storage area for the things you will create on the computer.
T-LIST: COMPUTER PARTS AND WHAT THEY DO.

<table>
<thead>
<tr>
<th>Computer Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor</td>
<td>Screen; like a TV</td>
</tr>
<tr>
<td>CPU</td>
<td>System unit; the computer itself</td>
</tr>
<tr>
<td>Mouse</td>
<td>Gives commands or orders to the computer</td>
</tr>
<tr>
<td>Keyboard</td>
<td>Used to type your work</td>
</tr>
<tr>
<td>RAM</td>
<td>Memory; the “brain” capacity</td>
</tr>
<tr>
<td>Drives</td>
<td>Storage; where you keep the documents that you create</td>
</tr>
<tr>
<td>Processor</td>
<td>Microprocessor; the “heart”; it’s in control; everything goes through the processor.</td>
</tr>
</tbody>
</table>
The PC Hardware

The CPU

3 Major parts in the CPU:

- **Processor**: it controls everything.
- **RAM**: the "brain" capacity of the system.
- **Drives**: storage for your documents.

The central processing unit, or CPU, is the computer itself, the major component of your system. It is also referred to as the system unit. It contains the following parts:

1. **Microprocessor** - The microprocessor is the "heart" of your computer. It is one chip that does the processing and passes on instructions to other parts of the computer.

2. **Memory (RAM)** - These are the chips that temporarily hold your data while you work on your document.

3. **Storage** - Floppy disks and hard drives are storage devices. You save the work you have created on the hard drive or diskette (floppy disk) so you can go back to it at another time. These drives are named A: (the floppy drive), C:, D:, F: etc.

Think of the drives as the drawers in your file cabinet. Files (your documents) are organized on your disks and hard drives in folders and subfolders which are analogous to hanging folders and manila folders in your file cabinet. The drives can hold billions (giga) of characters (bytes) of information.
## The PC Hardware (Cont.)

### PC Keyboard

PC keyboards have the letter keys set up like a typewriter. They also have special keys.

1. **Functions keys** (F1, F2, ... ) carry out tasks when you hit them alone or in combination with other keys like the Shift or Ctrl keys. For example, F1 usually puts the user into on-line Help.

2. **Tab, Arrow keys, Home, End, Page Up and Page Down** are used to move the insertion point (the blinking cursor) around.

3. **Control (Ctrl) and Alt** work like the **Shift** key. By themselves they don’t do anything, but in combination with another key they will change the effect of that key. For example, if you hold the **Shift** key and strike a letter, it changes it to a capital letter.

4. **Backspace and Delete** are two ways of deleting text. The Delete key deletes to the right or **forwards** from the insertion point, but the Backspace key deletes to the left or **backwards** from the insertion point.

### Keys needed to log on:

- Ctrl
- Alt
- Delete
- Tab
The PC Hardware

The CPU

The central processing unit, or CPU, is the computer itself, the major component of your system. It is also referred to as the system unit. It contains the following parts:

1. **Microprocessor** - The microprocessor is the "heart" of your computer. It is one chip that does the processing and passes on instructions to other parts of the computer.

2. **Memory (RAM)** - These are the chips that temporarily hold your data while you work on your document.

3. **Storage** - Floppy disks and hard drives are storage devices. You save the work you have created on the hard drive or diskette (floppy disk) so you can go back to it at another time. These drives are named A: (the floppy drive), C:, D:, F: etc.

Think of the drives as the drawers in your file cabinet. Files (your documents) are organized on your disks and hard drives in folders and subfolders which are analogous to hanging folders and manila folders in your file cabinet. The drives can hold billions (giga) of characters (bytes) of information.
PC keyboards have the letter keys set up like a typewriter. They also have special keys.

1. **Functions keys** (F1, F2, ...) carry out tasks when you hit them alone or in combination with other keys like the Shift or Ctrl keys. For example, F1 usually puts the user into on-line Help.

2. **Tab, Arrow keys, Home, End, Page Up and Page Down** are used to move the insertion point (the blinking cursor) around.

3. **Control (Ctrl) and Alt** work like the **Shift** key. By themselves they don’t do anything, but in combination with another key they will change the effect of that key. For example, if you hold the **Shift** key and strike a letter, it changes it to a capital letter.

4. **Backspace and Delete** are two ways of deleting text. The Delete key deletes to the right or **forwards** from the insertion point, but the Backspace key deletes to the left or **backwards** from the insertion point.
SEQUENCE CHART – STARTING THE COMPUTER AND LOGGING ON

1. Turn the Power Switch to ON

2. Press CTRL and ALT and DELETE at the same time when the message to do so appears on the screen.

3. Type your User Name

4. Press the TAB key.

5. Type your password.

6. Press ENTER.
Narrative - Lesson Plan 2

As I did with Lesson 1, I rewrote Lesson 2 in its entirety to provide more guidance for a new ESL teacher. As I rethought the lesson, I found ample opportunity to utilize sheltered strategies.

One of my main objectives throughout this unit is to try to increase interaction between students. The act of using a computer generally doesn’t lend itself to communicative activities. The computer user interacts with the machine. And so it is throughout much of a computer class: the instructor models the sequence of commands and the students practice on their own.

In this lesson I have incorporated one small group activity and two pair activities. In the small group, three students are asked to compare the computer systems in the ads that they bring to class and then to decide which of the three is the best system. I like this activity for two reasons. First, it reinforces the descriptors that are introduced in the lesson. Second, this activity is very helpful for those who are considering buying a computer. It clarifies for many students the information overload that people encounter when they shop for computers.

The first pair activity asks each student to instruct their partner on the use of the mouse. The second pair activity is a type of assessment. The students are asked to complete specific commands on their computer while their partner watches and coaches if necessary.

I continue to develop key vocabulary by using the word wall and the formulaic expressions that are part of the Functional-Notional Chart. In the modified lesson I have also included a listening guide for the parts of a window program. The students can fill in the new words as they are introduced.

AR
Modified Lesson Plan 2: Working with Windows (90 min.)

Objectives:

1) To learn more about a computer system by introducing descriptors
   - All will identify the descriptors.
   - Most will identify and briefly state what the descriptor means.
   - Some will describe each descriptor in detail and compare descriptors.

2) To identify the parts of a window and describe what each part does.
   - All will name and use the parts of a window.
   - Most will name and briefly summarize what each part does.
   - Some will describe in detail what happens when each part is used.

3) To learn how to use menus and toolbars.
   - All will demonstrate the use of the menus and toolbars.
   - Most will demonstrate and briefly tell others how to use the menus and toolbars.
   - Some will describe in detail how to use the menus, what the various symbols on
     the menus mean and how to use the toolbars.

Bring to Class:

Computer advertisements
Candy Bars
# Functional – Notional Chart, Lesson 2

<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>SITUATION</th>
<th>FORMULAIC EXPRESSIONS</th>
<th>GRAMMAR</th>
<th>VOCABULARY</th>
</tr>
</thead>
<tbody>
<tr>
<td>DESCRIBE</td>
<td>Parts of a computer system</td>
<td>The computer system comes with a ______ monitor.</td>
<td>Adjectives</td>
<td>Flat screen; CRT; 15&quot; or 17&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The system has a _______ processor.</td>
<td></td>
<td>Color; Mega; Giga; Bytes;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The system has _______ of memory.</td>
<td></td>
<td>Megabytes; Gigabytes;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The system has _______ of storage.</td>
<td></td>
<td>Pentium; Celeron</td>
</tr>
<tr>
<td>NAME</td>
<td>Parts of a program window</td>
<td>All windows have ________.</td>
<td>Nouns</td>
<td>Title Bar; Menu Bar; Menu</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Toolbar; Tooltips; Borders;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Control Buttons; Minimize</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Button; Maximize Button;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Close (X) Button; Restore;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(a window)</td>
</tr>
<tr>
<td>DEMONSTRATE</td>
<td>Controlling windows</td>
<td>Use the _______ to move up or down in a window.</td>
<td></td>
<td>Scroll Bar; Scroll Arrow;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use the _______ to make the window smaller.</td>
<td></td>
<td>Scroll Box</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use the _______ to give commands.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Lesson 2

Initiation (5 min.)
Ask students (show of hands) how many had success finding a computer ad. Teacher has extras for anyone who did not bring in an ad. Teacher holds up her ad and points out the main components of the advertised system.

Modification for Early Production and Speech Emergence ELLs
The teacher slows her pace and repeats sentences from the Functional – Notional chart on page 21. For example:

- This computer has a monitor.
- This computer has a mouse.
- This computer has a CD (drive).

The teacher points out that the ad contains words that they did not discuss in the last lesson. Ask the students if there are words in their ads that they don’t understand (show of hands).

A. Introduce Descriptors (15 min.)
Ask the class to share the new words in their ads. Model pronunciation whenever needed.

Modification for Early Production and Speech Emergence ELLs
- Add all new words to the word wall under the item it is describing.
- Use the formulaic expressions in the F-N Chart on page 21 to describe.

The (computer) system has a 17” monitor.
The (computer) system has a Pentium processor.
The (computer) system has a 40GB hard drive.

Ask for any words or numbers describing the monitor. Elicit 15”, 17”, color, flat screen and CRT. Talk about monitor options. Ask them the difference between flat screen and CRT.

Ask for any words or numbers describing the hard drives. Elicit GB or gigabytes. Define byte; define giga; ask them what is 60 gigabytes. Show abbreviation GB. Tell them “more is better.”
Ask for any words or numbers describing the processor. Elicit Pentium and Celeron. Define as product name.

Ask for any words or numbers describing memory. Elicit MB or megabytes. Define mega; ask them what is 512 megabytes. Show abbreviation MB. More is better!

B. Review of Computer Components via Student Ads (15 min.)
Students will review computer system components learned in Lesson 1 and new descriptors by working with their ads.

Modification for Early Production and Speech Emergence ELLs
Grouping: Break the class into groups of 3 and give them 8 minutes to complete the comparison chart on page 26. Each student will fill in the blanks for his/her own system. They should ask their teammates for help if they are having difficulty deciphering their ad. Once the chart is completed, ask them to reach a consensus on the best system of the 3.

Bring the class back and have each group report orally on the best system of the 3 ads. Ask them to give as many reasons as they can for choosing it, i.e., more memory or better monitor.

C. Review Logging On and Mouse Skills – Hands on Manipulative Activity (10 min.)
Assessment by teacher observation: Teacher asks students to turn on the systems and log on. Teacher circulates and if anyone is having trouble, she tells them they can use their Sequence Chart.

Give students 5 minutes to practice with the mouse using items on the desktop. Assessment by teacher observation: Teacher circulates and helps as needed.

Modification for Early Production and Speech Emergence ELLs
Pair work: Have each student tell their partner how to use the mouse to select an item, open an item and move an item. Teacher models task with a student first.
D. Parts of a Window and What They Do - Hands on Manipulative Activity (30 min.)
Teacher instructs students to locate the My Computer icon on the desktop and open it.

**Modification for Early Production and Speech Emergence ELLs**
- Teacher hands out the graphic (listening guide) of the “window” and suggests students label it to help learn the new words. *(See page 27)*
- Teacher adds all new words to the word wall.

Teacher models all instructions on her computer which is attached to a projector. Teacher defines, describes and demonstrates the control buttons, minimize, maximize, close, sizing a window using the borders, moving a window with the title bar, seeing other parts of the window with the scroll bars.

**Modification for Early Production and Speech Emergence ELLs**
- Teacher uses the formulaic expressions in the F-N Chart on page 21 as much as possible. For example:
  - All windows have a **title bar**.
  - All windows have a **close button**.
  - All windows have **menus**.
- Teacher slows the pace in this section as a lot of new vocabulary is introduced at once.

Teacher allows ample time for students to “play” with these controls. Teacher encourages students to explore and experiment. Students are gaining valuable mouse practice in this part of the lesson. Teacher refers students to the graphics and T-list on pages 13 and 14 in the student manual.

Teacher introduces Menus and Toolbars as a means of issuing commands to the computer, for example, “Save” or “Print” or “Copy”. Explore the menus and look at the various symbols on them and what they mean. Explore the toolbars and notice the **tooltips**. Stress use of the tooltips to more quickly learn what the buttons on the toolbars will do. Refer students to pages 15 - 16 of the student manual.
E. Assessment: Open a Program Window and Use the Appropriate Parts to Issue Commands. (10 min.)

Teacher instructs students to open the icon on their desktop named Internet Explorer. She tells the class what this program does (Internet browser). Her directions to the class are to listen and to follow her directions as she tells them to manipulate the window, one command at a time. For example, she will say: “Maximize the window,” and then wait while everyone does it and also watches to see who is having difficulty. After reviewing the window commands in this way, she distributes the Assessment Checklist worksheet on page 28.

Modification for Early Production and Speech Emergence ELLs

This part of the assessment gives ELLs some more exposure to the written word, but with a partner as a resource. Students will work in pairs. Both students need to complete all of the steps and check off the steps on the worksheet as they are completed. They may help each other. The key vocabulary words in each step are in all caps to further assist the Early Production ELLs.

Teacher circulates to see who is having difficulty. Candy bars for the first 3 teams to complete the assignment! Oh, teacher just happens to have enough candy bars for everyone!

Closure. (5 min)

Ask for any questions. Use word wall to review the new descriptors for a computer system as well as those words that pertain to parts of a window.
COMPARISON OF ADVERTISEMENTS

In groups of three (3), complete the following information on the computer systems in your ads.

<table>
<thead>
<tr>
<th>Computer Component</th>
<th>Ad 1</th>
<th>Ad 2</th>
<th>Ad 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor Type</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Size</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Processor Type</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other?</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Drives</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Floppy (Y/N)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CD (Y/N)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hard Drive Capacity?</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Software</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows Version</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other?</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cost</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Which computer system do you think is the best - #1, #2 or #3?
ASSESSMENT CHECKLIST

Complete these activities working in pairs. Check off each activity as you complete it. Internet Explorer should be open on your computer.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Student 1</th>
<th>Student 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLOSE the program.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ReOPEN the program.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MINIMIZE the window.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MAXIMIZE the window.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RESTORE the window.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Make the window small using the BORDERS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MAXIMIZE the window.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Find the SAVE command on a MENU.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Find the PRINT BUTTON on a TOOLBAR.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Find the PRINT command on a MENU</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CLOSE the window.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Created by Anita Russo

FLA 518

July, 2005
Lesson 3
Narrative - Lesson Plan 3

Lesson 3 is very exciting because this is when students start making connections and apply what they know about one program to another. They begin to see the similarities of all Windows-based programs. Because of the similarities, each subsequent program is easier to learn. In this lesson the students actually produce something on a computer. Students generally feel an increase in their confidence level at this point.

As I started to rewrite the third lesson, I realized that a great deal of new information is presented here. Consequently I have instructed the teacher on many occasions to reduce the linguistic load by making use of the formulaic expressions in the F-N Chart, and by using questions that are appropriate for Early Production ELLs such as yes/no and one-word answers.

Since the students actually will begin using real programs in this lesson, I found it necessary to rewrite a couple of the exercises for the ELLs to make the activities clearer. In one of the exercises where they are creating the beginning of a memo, I tell the students to use L1 if they prefer and if it is feasible (re: alphabet).

I have rewritten the lesson so that the students work in pairs for two activities. 1) to complete a graphic of window controls; and 2) to discover the elements that all Windows programs have in common.

Ongoing assessment by teacher observation is critical at this point. Since this is when the students actually start to become productive on a computer, it is essential that frustration be kept to a minimum. The teacher needs to be observant and ready to provide scaffolding at all times.

AR
Modified Lesson Plan 3: The Start Menu, Taskbar and Working with Programs (90 min.)

Objectives:

1) To understand what the options on the Start Menu do.
   • All will identify the options.
   • Most will name and briefly state what the option does.
   • Some will describe each option in detail.

2) To learn to use the Start Menu to open programs.
   • All will open programs from the Start menu.
   • Most will open programs from the Start menu and describe how to do it.

3) To learn to use the Taskbar to “multi-task”.
   • All will use multiple programs at the same time.
   • Most will use multiple programs at the same time and briefly describe the process.
   • Some will describe in detail the process of how to use multiple programs at the same time.

4) To recognize the similarities of all windows programs while learning to use some Windows Accessories programs.
   • All will work with several Windows programs.
   • Most will work with several programs and will describe their similarities.
   • Some will use several programs and describe in detail how they are similar.

Bring to Class:

A Calculator
## Functional – Notional Chart, Lesson 3

<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>SITUATION</th>
<th>FORMULAIC EXPRESSIONS</th>
<th>GRAMMAR</th>
<th>VOCABULARY</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEFINE</td>
<td>Options on the Start Menu</td>
<td>On the Start Menu you will find ____________.</td>
<td></td>
<td>Start (Button)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use the ____________ option to find your recent documents.</td>
<td>Start Menu</td>
<td>Programs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use the ____________ option to change computer settings.</td>
<td>Documents</td>
<td>Settings</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use the ____________ option to find your files.</td>
<td>Search</td>
<td>Help</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use the ____________ option to start programs.</td>
<td>Run</td>
<td>Shut Down</td>
</tr>
<tr>
<td>USE</td>
<td>The Taskbar</td>
<td>Use the Taskbar to ____________.</td>
<td></td>
<td>Taskbar</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Multi-task</td>
<td>Switch</td>
</tr>
<tr>
<td>COMPARE</td>
<td>Windows Programs</td>
<td>All windows programs have ____________.</td>
<td></td>
<td>Title Bar</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Menu Bar and Menus</td>
<td>Toolbar and Tooltips</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Borders</td>
<td>Control Buttons</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Minimize Button</td>
<td>Maximize Button</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Close (X) Button</td>
<td>Scroll Bars</td>
</tr>
</tbody>
</table>

Created by Anita Russo

July, 2005
<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>SITUATION</th>
<th>FORMULAIC EXPRESSIONS</th>
<th>GRAMMAR</th>
<th>VOCABULARY</th>
</tr>
</thead>
<tbody>
<tr>
<td>USE</td>
<td>Windows Programs</td>
<td>To write a letter, use _________.</td>
<td></td>
<td>Application or Program</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To draw a picture, use ________.</td>
<td>Proper Nouns</td>
<td>Program</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To add numbers, use ________.</td>
<td></td>
<td>Windows Accessories</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To make a capital letter, use ________.</td>
<td></td>
<td>WordPad</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Paint</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Calculator</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Word</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Excel</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>PowerPoint</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Microsoft Office</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Shift Key</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Space bar</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Colon</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Enter Key</td>
</tr>
</tbody>
</table>
Lesson 3

Initiation (5 min.)
Ask how many people use a calculator. (Show a calculator.) Ask how many people like to draw. (Draw on the whiteboard.) Ask how many people can write a short note. Tell them that they are going to do all of that in class today, but on a computer.

Ask students to take a couple of minutes to review the words on the word wall and ask if they have questions about any of them. If anyone asks for clarification, ask the class to help define the word.

A. Review (10 min.)
Explain that the reason that computers are easier these days, is that all programs work within windows and all windows have the same parts that do the same thing from program to program. Once they master “windows”, they can readily learn new programs.

Modification for Early Production and Speech Emergence ELLs
- Distribute a graphic of a window (see page 38) and tell them to work with a partner to label it and to review what each part does. Give them 4 minutes.
- Ask individuals to define what each part does. For Early Production ELLs, use questions with yes/no or either/or answers. For example:
  - Do you use the minimize or maximize button to make the window bigger?
  - When you click on the X button in the corner, does the window close?
- Use the formulaic expressions in F-N chart on page 31 to stress consistency in windows programs. For example:
  - All windows have a maximize button.
  - All windows have toolbars.
B. The Start Menu - A Hands-on Manipulative Activity (20 min.)
Have the students click on Start and look at the options on the Start Menu. Add all new words to the word wall. Tell students that this is how they will find the programs on their systems and how they will start the programs. Point out that Programs is one of the options. Ask who remembers the definition of program. (Software, Word, e-mail, etc. are all OK.)

Model for the students how to access each of the options (except Programs) of the Start Menu by simply clicking. As the class accesses each option, the teacher briefly describes what each does. Teacher tells the students that this course focuses on the Program options. The other options are covered in other courses.

Modification for Early Production and Speech Emergence ELLs
- Refer the class to the T-List describing the Start Menu on page 19 in the student manual.
- Teacher reads through the list to summarize.
- Teacher uses the formulaic expressions in the F-N Chart on page 31. For example:
  - Use the Settings option to change your computer's setup.
  - Use the Search option to find files.

C. The Taskbar and Task Switching - A Hands-on Manipulative Activity (10 min.)
Remind the students that the Taskbar is the bar at the bottom of the screen. Ask who remembers what the Taskbar does. (Holds buttons for each open program so user can "bounce around").

Assessment by observation: During this section, teacher pays close attention to students' facility with the mouse and understanding of words used to describe things on the desktop. She provides scaffolding where/when necessary.

Teacher has students open My Computer (icon on the Desktop) and notice the button for it on the Taskbar. Teacher has the students minimize My Computer to show that the program is still open (according to the Taskbar), but they have simply "set it aside" while they do something else.
Teacher has the students open The Recycle Bin and notice the button for it on the Taskbar. Teacher directs the students to close The Recycle Bin and notice that the button for it is no longer on the Taskbar. Direct the students to reopen the Recycle Bin.

Direct the students to switch (put on word wall) to My Computer via the button on the Taskbar. Direct the students to switch back to the Recycle Bin. Direct the students to minimize any programs they have open so they can see the Desktop again. Tell students to open a 3rd program, Internet Explorer. Tell them to practice switching from one to another using the buttons on the Taskbar.

D. The Similarity of Windows -- A Hands-on Manipulative Activity (15 min.)
Direct the students to switch to My Computer. Have them point to the following areas of the window on their system. (This list is on the board.)

   The Close Button (don’t click it – just point!)
   The Title Bar
   The Menu Bar
   Display a menu
   The Toolbar
   Display a Tooltip
   The Scroll Bar
   The Minimize Button

Modification for Early Production and Speech Emergence ELLs
Students will do this entire activity in pairs with the partners checking/assisting each other. The teacher will circulate and assess by observation.

Tell students to switch to Internet Explorer and find the same items. Then switch to the Recycle Bin and do the same thing. Make sure a partner is checking.

Ask them to find the Copy command in the My Computer window. HINT: It’s on a menu. Once they locate it on the Edit Menu, tell them to find the same command in each of the other 2 programs they have open. They will see that it is in the same place – on the Edit Menu. Stress the consistency of Windows.
E. Using Programs - A Hands-on Manipulative Activity (25 min.)

Direct students to close all programs they have open. They will now open programs from the Start Menu. Teacher models how to click on Start, move the mouse to Programs and slide over to the submenu (add to word wall) and move up or down to find the program.

Direct students to open WordPad, one of the Accessories (word wall). Point out how similar it is to the other programs they have been using, with all the same parts such as the control buttons, menus, etc.

Teacher gives basic instructions about WordPad, a word processing program (word wall), used for typing documents: use the Shift key for capital letters and colon; use the Enter key to drop down a line; use the space bar for spaces, and use Backspace key if you make a mistake. Teacher models and students try the various keys.

Instruct students to turn to page 26 in the student manual and follow the steps to create the beginning of a memo.

Modification for Early Production and Speech Emergence ELLs

Provide the modified exercise on page 39 for ELLs. Original exercise is on page 41. Students may use L1 if they prefer and if it is feasible (re: alphabet).

When they are done, teacher instructs the students to leave the WordPad program open and go back to the Start Menu and open another Accessory called Calculator. Teacher models again how to slide up and across on the Program submenus. Teacher gives basic instruction on how to use the Calculator.

Teacher instructs students to turn to page 27 in the student manual and follow the steps to add some numbers.

Modification for Early Production and Speech Emergence ELLs

Provide the modified exercise on page 40 for ELLs. Original exercise is on page 42.
When they are done, teacher instructs the students to leave the WordPad program open and go back to the Start Menu and open another Accessory called Paint. Teacher models again how to slide up, down and across on the Program submenus. Teacher asks what similarities they see to other programs, for example, WordPad.

Teacher models basic instructions on how to use Paint: select a color, select a tool and drag the mouse to draw. Teacher instructs the students to select red and select the spray can tool or the paint brush tool and draw an apple.

Teacher tells the students to switch back to their memo and asks if it is still there. Remind the students that right now the memo and the apple exist only in the "brain" of the computer, RAM or memory. When they close the program, they will be lost because they haven't stored them or saved them yet. We'll learn to do so in the next lesson.

**Closure (5 min.)**

Teacher instructs students to close WordPad and close Paint. Review the function of the taskbar, the similarities among programs, and what some programs do.

**Modification for Early Production and Speech Emergence ELLs**

- Using the formulaic expression in the F-N Chart on page 31, review the similarities of all windows. For example:
  
  All windows programs have a minimize button.
  All windows programs have menus.
  All windows programs have toolbars.

- Use the formulaic expression in the F-N Chart on page 31 to review these functions and programs:
  
  To switch programs, use ____________________.
  To write a letter, use ____________________.
  To draw, use ____________________.
  To add numbers, use ____________________.
Parts of a Window

[Diagram of a window with labeled parts: File, Edit, View, Help, C:, Act, Act40, Batch, Cribpro, Install, Internet, Internet Explorer 4, Program Files, PW/Plus, Qualcomm, Quickenw, 1 object(s) selected, Minimize, Maximize, Close, Minimize window, Maximize window, Close window, Minimize window, Maximize window, Close window.]
Exercise

Working with WordPad

1. Open WordPad:
   - Click on Start, point to Programs and Accessories.
   - Click on WordPad.
2. Type: *Today’s date*
3. Press the Enter key two times.
4. Type: *To: Bill Gates*
5. Press the Enter key two times.
6. Type: *From: Your Name*
7. Press the Enter key two times.
8. Type: *Subject: Budget*

Leave WordPad open and go on to the next exercise.
Exercise Working with Calculator

1. Open Calculator:
   - Go to Start, Programs and Accessories.
   - Click on Calculator.

1. Add 10 + 20. What is the answer?
2. Use the Taskbar to switch to WordPad.
3. Use the Taskbar to switch to Calculator.
4. Close the Calculator.
Exercise Working with WordPad

1. Go to Start, Programs and Accessories and open WordPad. Does a button for WordPad appear on the taskbar?
2. You will create a memo to your supervisor. Type the following then press the Enter key twice:
   3. Today’s date
4. Type the following then press the Enter key twice:
   5. To: Your Supervisor
6. Type the following then press the Enter key twice:
   7. From: Your Name
8. Type the following then press the Enter key twice:
   9. Subject: Budget

![Image of WordPad window with memo content]
### Exercise: Working with Calculator

1. Go to Start, Programs and Accessories and open the Calculator.
2. Use the Calculator program to add 10 plus 20. What did you get for an answer?
3. Use the Taskbar to go back to your memo that you started in WordPad. Is it still there?
4. Use the Taskbar to go back to Calculator and then close it.
Lesson 4
Narrative - Lesson Plan 4

Lesson 4, which deals with the computer's filing system, is a difficult lesson for all students. Relating a file cabinet to the computer drives is a very helpful strategy. The most difficulty that students encounter is working their way through the folder hierarchy on a computer.

As I rewrote Lesson 4, I relied heavily on realia to help convey the concepts of the lesson to the ELLs. The teacher shows the class disks, CDs, hard drives and pictures of file cabinets. In addition, a manila file folder with papers in it will help to make the connection to putting electronic files in folders.

The rewrite of this lesson also contains many instructions for the teacher to use the expressions in the F-N Chart. Repetition, repetition, repetition: "Drives hold folders." "Folders hold documents." "Save documents in a folder." Save folders on a drive." You just can't say it too much, not only for the ELLs, but for the mainstream students as well.

To clarify the most complex part of saving files, I added two sequence charts. One chart summarizes the process for creating a folder. The second chart clarifies the process of saving a file. I also rewrote some pages of the text to simplify instructions.

Because one of my original objectives (Attitude/Awareness) is for the students to feel comfortable using a computer, i.e., to raise their confidence level, at the end of this lesson I added a self-assessment rubric. Once completing it, I am sure the students will be impressed by how much they have progressed in the four lessons and I hope they will feel proud of that achievement.

AR
Modified Lesson Plan 4:  File Management (90 min.)

Objectives:

1) To understand the “drive, folder, and file” electronic filing system.
   • All will identify drives, folders and files.
   • Most will identify and briefly describe the difference between drives, folders and files.
   • Some will identify and describe drives, folders and files in detail.

2) To learn to create folders for storing files using My Computer.
   • All will create folders using My Computer.
   • Most will create folders and tell briefly how to do it.
   • Some will create folders and describe in detail how to do it.

3) To learn how to save files.
   • All will demonstrate how to save files.
   • Most will demonstrate how to save files and briefly describe the process.
   • Some will demonstrate and describe in detail the process of how to save files.

4) To learn how to find and open saved files.
   • All will demonstrate opening saved files.
   • Most will open files and briefly describe how to do it.
   • Some will find and open files and describe in detail the process.

Bring to Class:

- Disks
- CD’s
- Hanging folder
- Old hard drive
- Manila folder with papers in it
- Picture of a file cabinet.

Created by Anita Russo
FLA 518
July, 2005
## Functional – Notional Chart, Lesson 4

<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>SITUATION</th>
<th>FORMULAIC EXPRESSIONS</th>
<th>GRAMMAR</th>
<th>VOCABULARY</th>
</tr>
</thead>
</table>
| DEFINE   | Elements of the electronic filing system | The drives are your __________.  
The drives are the __________ areas for your files.  
A file cabinet has _____________.  
A computer has _____________.  
File Cabinet drawers hold __________ >  
Drives hold _____________.  
Folders hold _____________.  
Documents are files. | | File Cabinet  
Storage  
Drawers  
Drives  
Folders  
Files or Documents |
| USE      | My Computer | You can save folders and files on __________. | Prepositional Phrase | Disk.  
Hard Drive  
Floppy Drive  
CD  
A: Drive  
C: Drive  
Network Drive |
| ORGANIZE | Filing system | You save files in a ______________.  
You save documents in a ______________.  
You save a folder on a ______________. | Prepositional Phrase | Save  
Folder  
Drive |
<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>SITUATION</th>
<th>FORMULAIC EXPRESSIONS</th>
<th>GRAMMAR</th>
<th>VOCABULARY</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOCATE</td>
<td>Files on My Computer</td>
<td>You open the ____________ of the file cabinet.</td>
<td></td>
<td>Open</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You open the ____________ of the computer.</td>
<td></td>
<td>Drawer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You open the ____________ to find the file.</td>
<td></td>
<td>Drive</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Folder</td>
</tr>
</tbody>
</table>
Lesson 4

Initiation (5 min.)
Teacher holds up a picture of a *file cabinet* and asks how many (show of hands) know what it is. Teacher asks how many (show of hands) know how to use one or have used one. Teacher asks what’s inside a file cabinet (*folders*) and holds up hanging folder and manila folder. Teacher asks what’s inside the folder (*papers, documents, files*). Teacher tells the students that because they know about file cabinets, filing their work on their computer will be easy. Add all new words to word wall.

A. Review (5 min.)
Ask students to review the words on the word wall and tell which words have to do with storage on a computer. Elicit and put on whiteboard:

- Disk
- Hard Drive
- Floppy Drive
- CD
- A: Drive
- C: Drive
- Network Drive

As each word is given, use *realia* (hard drive, disk, etc.) to remind students of their meaning.

**Modification for Early Production and Speech Emergence ELLs**
Use the formulaic expression in the F-N Chart on page 45. For example:

- You can save files on a (floppy) disk.
- You can save files on the C: Drive.
- You can save files on a CD.
B. File Management Concepts (10 min.)

On the whiteboard review the drives and their names (letters) that a computer typically has for saving files. Draw a file cabinet next to it and equate each drive to a drawer in a file cabinet. A sample drawing can be found on page 54. If they have 3 drives, then they have a 3-draw file cabinet.

Modification for Early Production and Speech Emergence ELLs

Use the formulaic expressions in the F-N Chart on page 45. For example:

- A file cabinet has drawers.
- A computer has drives.

The drives are your file cabinet.
The drives are the storage areas for your files.

Teacher has the students start the computers and logon. Teacher observes to see that everyone can do it easily at this point.
C. Using My Computer - A Hands-on Manipulative Activity (10 min.)
Teacher models all instruction, then has the students do it. Teacher tells the students to find My Computer icon on the Desktop and open it. Assessment by teacher observation:
Teacher observes if anyone is still having difficulty using the mouse or recognizing items on the Desktop.

Teacher tells the students that My Computer is their “file cabinet” and what they see when they first open My Computer are the drives (drawers) that are available for storing their files.

Modification for Early Production and Speech Emergence ELLs
Use the formulaic expressions in the F-N Chart on page 45. For example:
- Cabinet file drawers hold folders.
- Drives hold folders.
- Folders hold files/documents.

Teacher discusses the 4 types of drives (floppy, CD, local hard drive, network hard drive) and how they differ. Teacher points out how the icons for the drives differ. Teacher tells the students that the best place (drawer/drive) to save files is the network drive if they have one. Otherwise they should use the local hard drive (C:).

Modification for Early Production and Speech Emergence ELLs
Distribute graphic on page 55 to define the difference between drives.

Teacher tells students that they open a drive just like they would open anything else – by double-clicking on it. Have students open the C: drive and view the folders. Have students open the network drive and view the folders. Remind students of the file cabinet analogy – the drawers (drives) hold folders.

Modification for Early Production and Speech Emergence ELLs
Use the formulaic expressions in the F-N Chart on page 45. For example:
- You open the drawer of a file cabinet.
- You open the drive of a computer.
- You open the folder to find a file (document).
Have students open various folders to see the files. Remind students that files are any kind of document: a letter, a memo, a drawing, or anything you can create on a computer. Point out that electronic folders can hold other folders as well as files, just like hanging or pendafile folders can.

**D. Creating Folders - A Hands-on Manipulative Activity (15 min.)**
Teacher models all instruction, then has the students do it. Teacher tells the students that they need to put their own folders in the drives so they have a place to save their files, just like they would do with a file cabinet. Teacher models the steps and then refers students to page 33 of the student manual.

*Modification for Early Production and Speech Emergence ELLs*
See page 56 for rewritten page that includes a sequence chart. The original text follows it on page 57.

Teacher has the students create several files, one of which they will name *My Data.*

**Assessment by teacher observation:** Teacher circulates and helps as needed. Teacher shows the students that they can have an electronic folder act as a pendafile or hanging folder with other folders in it. These are called *subfolders* (word wall). The steps are the same. Have students create several sub folders.

Direct students to close My Computer (the file cabinet)
E. Creating and Saving Files - A Hands-on Manipulative Activity (25 min.)
Teacher asks students who remembers how to open WordPad? Teacher elicits the steps and **models** how to click on **Start**, move the mouse to **Programs** and slide over to the **submenu** and move up or down to find the program. Direct students to open **WordPad**, one of the **Accessories**.

Teacher reviews basic instructions about WordPad, a **word processing** program (point to word wall), by asking questions.

**Modification for Early Production and Speech Emergence ELLs**
Use questions requiring only one word answers. For example:

What key makes a capital letter?
What key moves you down one line?

Instruct students to turn to page 26 in the student manual and follow the steps to create the beginning of a memo as they did in the previous class.

**Modification for Early Production and Speech Emergence ELLs**
Provide the worksheet on page 58 for ELLs

Students may use L1 if they prefer and if it is feasible (re: alphabet).

When they are done, teacher asks what program they would use to draw a picture. (Elicit Paint.) Teacher instructs the students to leave the WordPad program open and go back to the Start Menu and open another Accessory called Paint.

Teacher **models** basic instructions on how to use Paint: select a color, select a tool and drag the mouse to draw. Teacher instructs the students to select **any color**, select the **spray can tool** or the **paint brush tool** and draw anything they want.

Teacher tells the students to switch back to their memo and asks if it is still there. Remind the students that right now the memo and the picture exist only in the “brain” of the computer, RAM or memory. If they close the programs now, they will be lost because they haven’t **stored** them or **saved** them yet.
Instruct students to find the Save command (hint: it’s on a menu and on the toolbar). Once they find it have them click on it. Direct the students to page 35 of the student manual for the steps for saving a document.

**Modification for Early Production and Speech Emergence ELLs**

Distribute Saving Files Sequence Chart. See page 59

Teacher explains that every program has a direct link to their file cabinet and that is what they are seeing in the Save As window. When they save a file, they need to do 2 things: 1) Choose the folder to put it in and 2) give it a name. Teacher demonstrates the Save in text box and the drop down menu (word wall) which will show them a list of their drives (drawers in a file cabinet). Ask them which drive they created their folders on. Tell them to click on that drive and they will see a list of their folders. Instruct students to find the folder called My Data and open it by double-clicking.

Call students’ attention to the File name box at the bottom of the window. Tell them to type the name First Memo, and then click Save. When they return to the document, instruct them to close it.

Tell students to go through the same steps for saving their picture in Paint. They should use the Sequence Chart as a guide. Suggest they call it My Art. After they have saved it, teacher directs them to close Paint.
F. Locating and Opening Files - A Hands-on Manipulative Activity (10 min.)

Ask students if they think they will ever see their documents again! Ask where they think they should look for their memo and picture. Elicit My Computer, hard drive, (network drive), My Data folder.

Instruct students to open My Computer. Ask which drive they put the My Data folder on. Tell them to open that drive and then open the My Data folder. When they see First Memo tell them to open it. (How?) Ask if the memo is still there, is it OK? Tell them to add the sentence “I love computers!” (on the whiteboard). Explain the need to save it again. Close out of WordPad.

Tell students to switch back to My Computer and find their picture called My Art. Where is it? Tell them to open it and add some more detail to it. Save the file again. Close out of Paint.

Closure. (10 min.)

Use the word wall and file cabinet pictures to review the electronic filing system. Ask for any questions. Remind students that they have come a long way in 4 short lessons.

Modification for Early Production and Speech Emergence ELLs and all students

Ask them to complete the Self Evaluation Rubric on page 60.
FILE MANAGEMENT CONCEPTS

- 3½ Floppy (A:)
- Local Disk (C:)
- Classroom on 'Zeus' (G:)

3-Drawer File Cabinet
## COMPARISON OF DRIVES

<table>
<thead>
<tr>
<th>3½ Floppy (A:)</th>
<th>Local Disk (C:)</th>
<th>Classroom on 'Zeus' (G:)</th>
<th>Compact Disc (D:)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Uses disks (floppies)</td>
<td>Part of your system</td>
<td>On the “network”; not part of your system.</td>
<td>Not all CD drives are able to “write”; look for CD-RW label (for Read &amp; Write)</td>
</tr>
<tr>
<td>Portable</td>
<td>Safer than floppies</td>
<td>Safest place because networks are backed up daily</td>
<td>Some are CD/DVD combinations</td>
</tr>
<tr>
<td>Easily lost or damaged</td>
<td>Lots of storage space</td>
<td>Lots of storage space</td>
<td></td>
</tr>
<tr>
<td>1.44MB</td>
<td>40GB, for example</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Modified Text

To Create Folders

Files can be copied, moved, renamed or deleted in My Computer. You can also create Folders in which to store your files (documents). To create a new folder:

1. Open the drive (double-click it) that you want to create the folder on.
2. Click on the File menu then New and Folder.
3. “New Folder” will be highlighted (blue). Immediately begin typing the name you want for the folder and press Enter.

SEQUENCE CHART – CREATING FOLDERS

Open the drive.

Click on the FILE Menu, then NEW, then FOLDER

Type the name for the Folder.

Press ENTER
My Computer (Cont.)

To Create Folders

Files can be copied, moved, renamed or deleted in My Computer. You can also create *Folders* in which to store your files (documents).

To create a new folder:

1. Open the drive (double-click it) that you want to create the folder on.

2. Click on the **File** menu then **New** and **Folder**.

3. “New Folder” will be highlighted (blue). Immediately begin typing the name you want for the folder and press **Enter**.
Exercise  Working with WordPad

1. Open WordPad:
2. Go to Start, Programs and Accessories.
3. Click on WordPad.
4. Type: *Today's date*
5. Press the Enter key two times.
6. Type: *To: Bill Gates*
7. Press the Enter key two times.
8. Type: *From: Your Name*
9. Press the Enter key two times.
10. Type: *Subject: Budget*
SEQUENCE CHART – SAVING A FILE

On the FILE menu click SAVE.

On the Save in line (top of the Save As window) click the drop-down arrow.

Choose the DRIVE where you want to save the file.

Choose the FOLDER where you want to save the file. Double click to open it.

On the file name line at the bottom of the window, type a name for your document.

Press ENTER or click SAVE.
## SELF-EVALUATION RUBRIC

Please complete the following by placing a check ✓ in the appropriate box.

<table>
<thead>
<tr>
<th>Can you perform the following tasks?</th>
<th>Yes I can!</th>
<th>Still need some help.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name 4 main parts of a computer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tell what drives do</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Turn on and log on to a computer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use the mouse to move an item</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use the mouse to open an item</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open a program on the Start menu</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Close a program</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Minimize a window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximize a window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show what the scroll bar is for</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Find the Save command on a menu</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open more than one program at a time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Switch from one program to another</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Write a short note in Word</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Find folders in My Computer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create a folder</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save a file.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Lesson Plan – Class 1: Getting Started with Computers

Objectives:
- Hardware terminology
- Starting a computer
- The Windows desktop
- Using a mouse

Bring to Class:  Time: 1.5 Hours
- Student manuals
- Disks and CD’s

<table>
<thead>
<tr>
<th>Procedures:</th>
<th>Time:</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introductions:</td>
<td>10 min.</td>
<td></td>
</tr>
<tr>
<td>• Ask students to introduce themselves and tell what experiences they have had, if any, with computers.</td>
<td></td>
<td>Use head and heart analogy Show disks and CD’s</td>
</tr>
<tr>
<td>• Review objectives of today’s class.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computer Hardware</td>
<td>30 min.</td>
<td></td>
</tr>
<tr>
<td>• Define parts; focus on storage</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Look at and define special keys on keyboard</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Mouse – 2 buttons</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Find the power switch</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Software:</td>
<td>5 min.</td>
<td></td>
</tr>
<tr>
<td>• What is software?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• What is Windows?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Logging on:</td>
<td>10 min.</td>
<td></td>
</tr>
<tr>
<td>• Talk about security</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• User names and Passwords</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The Windows Desktop</td>
<td>10 min.</td>
<td></td>
</tr>
<tr>
<td>• Define the desktop and what it does</td>
<td></td>
<td>Virtual desktop imitates real desktop</td>
</tr>
<tr>
<td>• Define and identify icons</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Point out the Start Button and the Taskbar</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Using the Mouse</td>
<td>15 min.</td>
<td></td>
</tr>
<tr>
<td>• Teach click, drag, double-click and right-click</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Practice with the icons on the desktop</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Questions and wrap up</td>
<td>10 min.</td>
<td></td>
</tr>
</tbody>
</table>

Created by Anita Russo  FLA 518  July, 2005
Lesson Plan – Class 2: Working with Windows

Objectives:
- Mouse practice
- Parts of a window and what they do
- Using menus
- Using toolbars

Bring to Class: Time: Computer ads 1.5 Hours

Procedures: Time: Notes

<table>
<thead>
<tr>
<th>Procedures</th>
<th>Time:</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warm up/Review:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Any questions about what we covered so far</td>
<td>20 min.</td>
<td></td>
</tr>
<tr>
<td>• Review computer ads and discuss what the items mean</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Review mouse actions and practice with items on the desktop</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parts of a window</td>
<td>30 min.</td>
<td>Use My Computer Window</td>
</tr>
<tr>
<td>• Title bar</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Borders</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Control Buttons</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Scroll Bars</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Using Menus</td>
<td>5 min.</td>
<td>Use the View Menu in My Computer</td>
</tr>
<tr>
<td>• How to get to sub-menus</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Menu symbols</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Using Toolbars</td>
<td>10 min.</td>
<td></td>
</tr>
<tr>
<td>• Tooltips</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Using a program</td>
<td>15 min.</td>
<td></td>
</tr>
<tr>
<td>• Open Internet Explorer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Explore menus</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Explore tooltips</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Use the window control buttons to minimize, maximize and close</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Questions and wrap up</td>
<td>10 min.</td>
<td></td>
</tr>
</tbody>
</table>
Lesson Plan – Class 3: Start Menu, Taskbar and Working with Programs

Objectives:
- Options on the Start Menu
- Starting programs from the Start menu
- Using the Taskbar
- Using Windows Programs

Bring to Class: Time: 1.5 Hours

<table>
<thead>
<tr>
<th>Procedures:</th>
<th>Time:</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Warm up/Review:</strong></td>
<td>15 min.</td>
<td></td>
</tr>
<tr>
<td>• Any questions about what we</td>
<td></td>
<td></td>
</tr>
<tr>
<td>covered so far</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Review parts of windows and</td>
<td></td>
<td></td>
</tr>
<tr>
<td>what they each do.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>The Start Menu</strong></td>
<td>15 min.</td>
<td>Open several programs</td>
</tr>
<tr>
<td>• Define and discuss all options</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Programs: work with sub-menu</td>
<td></td>
<td></td>
</tr>
<tr>
<td>hierarchy</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Use the Start menu to start a</td>
<td></td>
<td></td>
</tr>
<tr>
<td>program</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>The Taskbar</strong></td>
<td>15 min.</td>
<td>Notice buttons on the Taskbar</td>
</tr>
<tr>
<td>• Buttons on the taskbar</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Task switching</td>
<td></td>
<td>Find Word, Excel and PowerPoint</td>
</tr>
<tr>
<td>• Minimizing windows</td>
<td></td>
<td>on the Start Menu</td>
</tr>
<tr>
<td>• Closing programs from the</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Taskbar</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Using Programs</strong></td>
<td>15 min.</td>
<td></td>
</tr>
<tr>
<td>• The similarity of all programs</td>
<td></td>
<td></td>
</tr>
<tr>
<td>due to windows</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Open several programs and</td>
<td></td>
<td></td>
</tr>
<tr>
<td>explore similarities: the</td>
<td></td>
<td></td>
</tr>
<tr>
<td>menu bar, toolbars, control</td>
<td></td>
<td></td>
</tr>
<tr>
<td>buttons, Taskbar buttons.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>The Accessories</strong></td>
<td>20 min.</td>
<td></td>
</tr>
<tr>
<td>• Use WordPad – keys to get</td>
<td></td>
<td></td>
</tr>
<tr>
<td>around: Enter, Shift for</td>
<td></td>
<td></td>
</tr>
<tr>
<td>caps.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Use the Calculator</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Use the Taskbar to switch</td>
<td></td>
<td></td>
</tr>
<tr>
<td>programs</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Questions and wrap up</strong></td>
<td>10 min.</td>
<td></td>
</tr>
</tbody>
</table>

Created by Anita Russo
FLA 518
July, 2005
# ORIGINAL PLAN

## Lesson Plan – Class 4: File Management

### Objectives:
- File management concepts
- Use My Computer
- Create folders
- Save files

### Bring to Class:
- File folders with papers in them
- A hard drive
- Floppy disks, CD’s

<table>
<thead>
<tr>
<th>Time:</th>
<th>1.5 Hours</th>
</tr>
</thead>
</table>

### Procedural Overview

#### Warm up/Review:
- Any questions about what we covered so far
- Review the Start Menu; open programs from the Start Menu
- Use the Taskbar to switch between programs

<table>
<thead>
<tr>
<th>Time:</th>
<th>10 min.</th>
</tr>
</thead>
</table>

#### File Management Concepts
- Define the drives as the filing system.
- How the drives are named
- Differentiate between floppy disks and hard drives
- Differentiate between folders and files

<table>
<thead>
<tr>
<th>Time:</th>
<th>30 min.</th>
</tr>
</thead>
</table>

#### My Computer
- Looking at folders and files in My Computer
- Opening Folders
- Different Views

<table>
<thead>
<tr>
<th>Time:</th>
<th>10 min</th>
</tr>
</thead>
</table>

#### Creating Folders
- Discuss where to create them – are some drives preferable?
- Create several on the C: drive

<table>
<thead>
<tr>
<th>Time:</th>
<th>10 min</th>
</tr>
</thead>
</table>

#### Saving a File
- Use WordPad to create a memo
- Save the document in a folder that was just created

<table>
<thead>
<tr>
<th>Time:</th>
<th>20 min.</th>
</tr>
</thead>
</table>

#### Questions and wrap up

<table>
<thead>
<tr>
<th>Time:</th>
<th>10 min.</th>
</tr>
</thead>
</table>

---

Created by Anita Russo

FLA 518

July, 2005
Checklists
## GRAMMAR AND FUNCTIONS CHECKLISTS

<table>
<thead>
<tr>
<th>Grammar</th>
<th>Lesson</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nouns</td>
<td>1, 2</td>
</tr>
<tr>
<td>Infinitives</td>
<td>1</td>
</tr>
<tr>
<td>Adjectives</td>
<td>2</td>
</tr>
<tr>
<td>Proper Nouns</td>
<td>3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Functions</th>
<th>Lesson</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>1, 2</td>
</tr>
<tr>
<td>List</td>
<td>1</td>
</tr>
<tr>
<td>Define</td>
<td>1, 3, 4</td>
</tr>
<tr>
<td>Recognize</td>
<td>1</td>
</tr>
<tr>
<td>Demonstrate</td>
<td>1, 2</td>
</tr>
<tr>
<td>Identify</td>
<td>1</td>
</tr>
<tr>
<td>Use</td>
<td>1, 3, 4</td>
</tr>
<tr>
<td>Describe</td>
<td>2</td>
</tr>
<tr>
<td>Compare</td>
<td>3</td>
</tr>
<tr>
<td>Organize</td>
<td>4</td>
</tr>
<tr>
<td>Locate</td>
<td>4</td>
</tr>
<tr>
<td>Sheltered ELL Strategies Checklist</td>
<td></td>
</tr>
<tr>
<td>-----------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>I. Contextualize Lesson</strong></td>
<td></td>
</tr>
<tr>
<td>1.1. Visuals (Realia, Manipulatives, Gestures)</td>
<td>Lesson 1</td>
</tr>
<tr>
<td>1.2. Model (Instructions, Processes)</td>
<td>9ff</td>
</tr>
<tr>
<td>1.3. Activate Background Knowledge</td>
<td>7</td>
</tr>
<tr>
<td>1.4. Negotiate Meaning/Check Understanding</td>
<td>11</td>
</tr>
<tr>
<td><strong>II. Make Text Comprehensible</strong></td>
<td></td>
</tr>
<tr>
<td>11.1. Graphic Organizers</td>
<td>9, 10</td>
</tr>
<tr>
<td>11.2. Develop Vocabulary</td>
<td>8, 9, 10, 11</td>
</tr>
<tr>
<td>11.3. Simplify Written Text</td>
<td>8, 14, 15</td>
</tr>
<tr>
<td><strong>III. Make Talk Comprehensible</strong></td>
<td></td>
</tr>
<tr>
<td>111.1. Graphic Organizers: Listening Guides</td>
<td>24, 27</td>
</tr>
<tr>
<td>111.2. Frame Main Ideas</td>
<td>8</td>
</tr>
<tr>
<td>111.3. Pace Teacher's Speech</td>
<td>8</td>
</tr>
<tr>
<td><strong>IV. Engage: Opportunities for Output</strong></td>
<td></td>
</tr>
<tr>
<td>111. Teacher Questioning and Response Strategies: Instructional Conversations</td>
<td>11</td>
</tr>
<tr>
<td>111. Small Group Work: (Including Info Gap Activities)</td>
<td>11</td>
</tr>
<tr>
<td>111. Meaningful, real-life activities; Students as researchers</td>
<td>9, 10, 11</td>
</tr>
<tr>
<td><strong>V. Engage at Appropriate Language Proficiency Levels</strong></td>
<td></td>
</tr>
<tr>
<td>111. Use questions appropriate for language levels</td>
<td>7</td>
</tr>
<tr>
<td><strong>VI. Literacy/Academic Development</strong></td>
<td></td>
</tr>
<tr>
<td>111. Allow use of L1 for planning and conceptualizing</td>
<td>36</td>
</tr>
<tr>
<td>111. Lots of real oral and written language</td>
<td>23</td>
</tr>
</tbody>
</table>
Final Reflective Narrative

I am very pleased with what I am taking away from this class. I now feel armed and ready for the next time I encounter ELLs in my computer classes, whereas before I have felt very helpless. I anticipate using a great number of the sheltered instruction strategies that I learned. Indeed I will use many of them in my mainstream classes whether ELLs are present or not!

My first new strategy to employ is the word wall. It may sound silly, but I can’t believe how excited I am about using a word wall! It’s such a simple concept – I don’t understand why I have never heard of it before, or thought of it before. I noticed as I was writing my lessons, I started out by writing ‘word wall’, then it became word wall, then it became Word Wall as it grew in importance in my mind! (I think I changed all the instances of the term back to normal!)

One of my favorite graphic organizers that I learned about is the sequence chart. I see me creating a number of them to simplify processes on the computer. Just about every task I teach has multiple steps to it, and some tasks can be pretty complex. A sequence chart will be a tremendous help to students as they are learning new processes. I see the sequence chart as one of the best tools for making my student texts more comprehensible.

Although I found the functional-notional charts laborious, I must admit that they made me think about the language I use in the classroom and how I use it. There is always a lot of new vocabulary to learn with each new software program. Using repetitive speech patterns can certainly help the learning process. Although I am sure that I won’t create F-N charts for my lessons, I know I will at least organize the new vocabulary in my head and give some thought as to how I will present it.

As the author of most of the student manuals that I use, I see many, many sections of many of my manuals that can be improved to make text more comprehensible. I revise curriculum and manuals on a pretty regular yearly cycle. As the manuals come up for revision, I will be looking at the text differently now and will undoubtedly simplify many sections.
Probably the one thing I am happiest about achieving in my unit is creating opportunities for the students to engage with each other. I have always believed that learners can learn a lot from one another. I have wanted to have more student interaction in my classes, but didn’t know how to accomplish it. I took a TESOL Methods course in the spring (at another institution!). Our final project was to create a unit of three lessons. I wanted the subject of my unit to be teaching computer usage, but the instructor strongly discouraged me, saying that working with a computer is not a communicative activity. I had to agree with him. However, now I know that there is no reason that the process of learning to use a computer can’t incorporate communicative activities. I am very pleased that I finally got to do what I wanted to do this past spring. I feel I want to take this unit to him and show him what I learned! Hmm…maybe I will.

AR
Original Lessons
Introduction to
Personal Computers
and
Windows
Introduction to
Personal Computers
and Windows

© 1999 – 2003 Discovery Training Services, LLC
# TABLE OF CONTENTS

LESSON ONE: GETTING STARTED ............................................................................. 1
- The PC Hardware .......................................................................................... 2
- Turning On The PC ....................................................................................... 6
- What is Windows? ......................................................................................... 7
- Logging On .................................................................................................. 8
- The Desktop .................................................................................................. 9
- Mouse Techniques ....................................................................................... 10

LESSON TWO: WORKING WITH WINDOWS .................................................... 11
- Parts of a Window ........................................................................................ 12
- Window Controls ......................................................................................... 12
- Working with Windows ............................................................................... 13
- Viewing Window Contents ......................................................................... 14
- Using Menus ................................................................................................ 15
- Using Toolbars ........................................................................................... 16

LESSON THREE: THE START MENU, TASKBAR AND WINDOWS PROGRAMS .. 17
- The Start Menu ............................................................................................ 18
- Starting a Program...................................................................................... 20
- The Taskbar .................................................................................................. 21
- Task Switching ............................................................................................ 23
- Windows Applications ............................................................................... 24
- The Accessories ........................................................................................... 25

LESSON FOUR: FILE MANAGEMENT ................................................................ 29
- File Management Concepts ........................................................................ 30
- My Computer ............................................................................................... 32
- Saving a Document ...................................................................................... 35
- Computer Shut Down .................................................................................. 37
- Notes ............................................................................................................ 38
Lesson One: Getting Started

Objectives

At the end of this lesson, you will be familiar with:

- Hardware terminology
- Logging on
- The Desktop
- Mouse Techniques
The PC Hardware

The CPU

The central processing unit, or CPU, is the computer itself, the major component of your system. It is also referred to as the system unit. It contains the following parts:

1. **Microprocessor** - The microprocessor is the "heart" of your computer. It is one chip that does the processing and passes on instructions to other parts of the computer.

2. **Memory (RAM)** - These are the chips that temporarily hold your data while you work on your document.

3. **Storage** - Floppy disks and hard drives are storage devices. You save the work you have created on the hard drive or diskette (floppy disk) so you can go back to it at another time. These drives are named A: (the floppy drive), C:, D:, F: etc.

Think of the drives as the drawers in your file cabinet. Files (your documents) are organized on your disks and hard drives in folders and subfolders which are analogous to hanging folders and manila folders in your file cabinet. The drives can hold billions (giga) of characters (bytes) of information.
The PC Hardware (Cont.)

PC Keyboard

PC keyboards have the letter keys set up like a typewriter. They also have special keys.

1. **Functions keys** (F1, F2, ... ) carry out tasks when you hit them alone or in combination with other keys like the Shift or Ctrl keys. For example, F1 usually puts the user into on-line Help.

2. **Arrow keys, Home, End, Page Up and Page Down** are used to move the insertion point (the blinking cursor) around.

3. **Control (Ctrl) and Alt** work like the Shift key. By themselves they don’t do anything, but in combination with another key they will change the effect of that key. For example, if you hold the **Shift** key and strike a letter, it changes it to a capital letter.

4. **Backspace and Delete** are two ways of deleting text. The Delete key deletes to the right or *forwards* from the insertion point, but the Backspace key deletes to the left or *backwards* from the insertion point.
5. The Caps Lock key allows you to type all in capitals without having to hold down the Shift key. When you hit the Caps Lock key, a light will turn on to indicate that Caps Lock is turned on. CAUTION: Passwords are often case sensitive – be sure that your Caps Lock key is off before entering your password.

6. The numeric keypad on the right side of most keyboards can be used as numbers or cursor movement keys. When you hit the Num Lock key, a light will turn on to indicate that Num Lock is turned on and the keypad can then be used for entering numbers.
### The PC Hardware (Cont.)

<table>
<thead>
<tr>
<th>Peripherals</th>
<th>Anything that is external to the CPU and plugs into it is called a <em>peripheral</em>. Monitors, printers, modems, mouse, external CD ROM drives and speakers, are all peripherals.</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Monitor</td>
<td>The monitor has its own Power Switch. It is generally located on the front of the monitor. NOTE: <em>Turning on/off the monitor is not the same as turning on/off the PC.</em> If a <em>screen saver</em> comes on while you are at the PC, simply move the mouse or press any key to get back to your program.</td>
</tr>
<tr>
<td>The Mouse</td>
<td>The left mouse button is the <em>primary</em> mouse button, used to select objects. The right mouse button is the <em>secondary</em> mouse button, used to access Shortcut menus.</td>
</tr>
</tbody>
</table>
The Power Switch is generally located on the front of the PC. Simply push it in. You may also have to turn on the monitor separately.

*Remember:* Turning on/off the monitor is *not* the same as turning on/off the PC.
What is Windows?

<table>
<thead>
<tr>
<th>Software</th>
<th>Windows is the first software that you encounter when you turn on your system. It is the software that runs your computer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>Windows is considered easy to learn and use because Windows makes use of lots of graphics and a mouse for pointing to these graphics. To tell the computer what to do, you point and click with the mouse.</td>
</tr>
</tbody>
</table>
Logging On

Log On

This is the first level of network security. The log on process controls who may access the network or access your computer. The log on procedure identifies you as a legitimate user. It requires a user name and password.

To log on:

1. When the message appears telling you to do so, press and hold the [CTRL] and the [ALT] keys and press the [DELETE] key to logon. The Logon Information dialog box opens.

2. Type your user name in the User Name text box. Press [TAB].

3. Type your password in the Password text box. The password will appear as asterisks for security reasons.

4. Press [ENTER].

NOTE: If you were the last one to log on to the system, Windows will remember your User Name and you will not have to re-type it.

You Need to Know...

1. Passwords are case sensitive. Make sure Caps Lock is not turned on when you enter your password.

2. It is recommended that you use a combination of letters and numbers in your password.

DO NOT GIVE OUT YOUR PASSWORD!!
The Desktop

When the computer is turned on, the display on the screen is referred to as the Desktop.

The pictures are called icons. Icons are graphic representations of documents, programs and computer hardware.

The gray bar at the bottom is called the Taskbar. It keeps track of the programs and windows that are open and allows you to switch between programs easily.

NOTE: Due to differences in computer systems and setups, you may have icons that are different than those appearing above.
# Mouse Techniques

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point</td>
<td>Move the mouse along the desktop until the tip of the arrow rests on the item of your choice.</td>
</tr>
<tr>
<td>Click</td>
<td>Quickly press and release the (left) mouse button. Used to select objects.</td>
</tr>
<tr>
<td>Drag</td>
<td>Press the mouse button and hold it down while moving the mouse and therefore the object it is pointing to.</td>
</tr>
<tr>
<td>Double-click</td>
<td>Click the mouse button twice very quickly. Used to start or open programs or documents.</td>
</tr>
<tr>
<td>Right-click</td>
<td>Click the right mouse button once on an object to bring up a shortcut menu.</td>
</tr>
</tbody>
</table>

*NOTE: The left mouse button is the **primary** mouse button, used to select objects. The right mouse button is the **secondary** mouse button, used to access the Shortcut menu.*
Lesson Two: Working with Windows

Objectives

At the end of this lesson, you will be familiar with:

- Parts of a window and what they do
- Using menus
- Using Toolbars
Parts of a Window

Menu Bar

Title Bar

Toolbar

Scroll Bar

Borders for Resizing the Window

Window Controls

Minimize  Maximize  Close

The Restore Button
Working with Windows

Moving a Window
1. Point to the window's title bar.
2. Click and Drag the window to the desired position.

Using the Borders to Size Windows
1. To adjust the size of a window, point to any border. The Pointer will change to a double-headed arrow.
2. Drag the border to expand or reduce the Window.

Using the Control Buttons

<table>
<thead>
<tr>
<th>Minimize</th>
<th>Maximize</th>
<th>Close</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Minimize Button" /></td>
<td><img src="image" alt="Maximize Button" /></td>
<td><img src="image" alt="Close Button" /></td>
</tr>
</tbody>
</table>

The Restore Button

1. The **Minimize** button puts the window on the Taskbar; it “sets it aside” while you do something else. **Clicking on the Minimize button does not close the program.**
2. Clicking on the **Maximize** button causes the window to expand to take advantage of the full screen.
3. Once a window is maximized, the middle button changes appearance. It is now called the **Restore** button. Clicking on it will restore the window to the size it was before you maximized it.

Closing a Window or a Program
Click the Close button in the upper right corner.
Viewing Window Contents

Viewing Window Contents

Often the entire contents of a window cannot be seen at one time. To view the remaining contents of the window, use the scroll bars available on the bottom and right-hand side of the window.

Scroll Bars

*Scroll bars* are used to move through windows horizontally and vertically to view unseen areas.

Scroll Box

*Scroll boxes* are used to move through window contents quickly by dragging the box along the scroll bar.

Scroll Arrows

*Scroll arrows* are used to move through a window in small increments by clicking on the arrows.
Using Menus

To Initiate Commands

Commands to perform various functions (such as Save, Print, Spell Check, etc.) are found on the menus accessed from the menu bar. A menu, just like in a restaurant, is a list of choices. To issue a command from a menu:

1. Click on an item on the menu bar and a menu will drop down.
2. Point to the choice you want and click.

Menu Symbols

Various conventions are used on the menus to guide users.

1. Bullet or Check Mark: That item is currently in effect.
2. Black Triangle ➔: Indicates that a submenu will appear when you point to that item.
3. Selection Letters: These are the underlined letter on a menu item. Pressing the designated letter on the keyboard will execute the command.
4. Ellipses ... : Ellipses on a menu item mean that the item will open a dialog box when selected.

Menu Bar
Using Toolbars

Toolbar Buttons

The buttons on a toolbar are an alternative way of issuing a command.

Tooltips

When you point to a toolbar button, a tooltip appears that describes what the button does when clicked. Tooltips are a great help when learning new software.
Lesson Three: The Start Menu, Taskbar and Windows Programs

Objectives

At the end of this lesson, you will be familiar with:

- The options on the Start menu
- Starting programs from the Start menu
- Using the Taskbar to switch between programs
- Using Windows programs
The Start Menu

The Start Menu is one way to begin programs, open documents and make changes to your computer environment. Several topics appear by default on the Start menu. In addition, users may add favorite programs to the Start menu.

NOTE: To access the Start menu with the keyboard, press Ctrl/Esc.
## The Start Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Programs</td>
<td>Choose this to start programs, such as Word or Excel.</td>
</tr>
<tr>
<td>Documents</td>
<td>Choose this to start work on a file that was recently used.</td>
</tr>
<tr>
<td>Settings</td>
<td>Choose this to make changes to desktop colors, printers, programs and hardware.</td>
</tr>
<tr>
<td>Search</td>
<td>Choose this to search for a particular file.</td>
</tr>
<tr>
<td>Help</td>
<td>Choose this to get help on any facet of Windows.</td>
</tr>
<tr>
<td>Run</td>
<td>This displays a command line for starting or installing programs.</td>
</tr>
<tr>
<td>Shut Down</td>
<td>Choose this when ready to turn off the computer.</td>
</tr>
</tbody>
</table>
## Starting a Program

<table>
<thead>
<tr>
<th>If an icon is on the Desktop</th>
<th>Double-click on the icon that represents the program.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the Start Menu</td>
<td>Use <strong>Start</strong> if a program is not yet running in memory.</td>
</tr>
<tr>
<td></td>
<td>1. Click <strong>Start</strong>, and trace to <strong>Programs</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. On the Program submenu, click the <strong>Program</strong> desired.</td>
</tr>
<tr>
<td>Closing a Window or a Program</td>
<td>Click the Close button in the upper right corner.</td>
</tr>
</tbody>
</table>

**NOTE:** To access the Start menu with the keyboard, press **Ctrl/Esc**.
The Taskbar

How does a button get on the Taskbar?

Whenever you open a program, a button for it will automatically appear on the Taskbar.

Note: If your system is setup to open some programs automatically when the computer is turned on, as soon as you see the Windows desktop, there will be buttons on the Taskbar.

Minimizing

If an application isn’t needed for several minutes, it may be preferable to minimize it to reduce clutter on the desktop.

Click the minimize button in the upper right corner of the application. The window will close, but the button for the program will remain on the Taskbar indicating that the program is still running.

Minimize All Open Windows at Once

In order to see the Desktop, you may need to minimize all open windows. To do so quickly, use the Minimize All Windows command on the Taskbar shortcut menu.

1. Right-click any empty space on the Taskbar.
2. Click Minimize All Windows.

©Discovery Training Services
Introduction to Personal Computers and Windows
## More on the Taskbar

<table>
<thead>
<tr>
<th>Several Uses for the Taskbar</th>
<th>The taskbar is used to:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. indicate how many programs are currently open.</td>
</tr>
<tr>
<td></td>
<td>2. allow switching between the programs which are currently open.</td>
</tr>
<tr>
<td></td>
<td>3. close documents and programs which are open.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Task Switching</th>
<th>To switch from one program to another:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. When a program is open, a button for it appears on the Taskbar.</td>
</tr>
<tr>
<td></td>
<td>2. Click the desired button on the Taskbar to go to that program.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Closing a Document or Program</th>
<th>To close a program:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. <em>Right-click</em> the desired button on the Taskbar.</td>
</tr>
<tr>
<td></td>
<td>2. Select <strong>Close</strong>.</td>
</tr>
<tr>
<td></td>
<td><em>Or,</em></td>
</tr>
<tr>
<td></td>
<td>1. Click on the button on the Taskbar to open the window.</td>
</tr>
<tr>
<td></td>
<td>2. Click on the X in the upper right corner.</td>
</tr>
</tbody>
</table>
Task Switching

Switching Between Programs with the Taskbar

If the program is already running, a button for it will appear on the Taskbar. Click the button (just once) to reopen that program’s window.

The Taskbar Shortcut Menu

- Cascade Windows
- Tile Windows Horizontally
- Tile Windows Vertically
- Minimize All Windows
- Undo Minimize All
- Task Manager...
- Properties
## Windows Applications

<table>
<thead>
<tr>
<th>An Application Window</th>
<th>All Windows programs have the same features of a <em>Menu Bar</em>, <em>Toolbar(s)</em>, <em>Status Bar</em> and <em>working area</em>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Menu Bar</td>
<td>The <em>menu bar</em> contains a series of menus that list commands such as <em>Open</em>, <em>Close</em>, <em>Print</em>, etc.</td>
</tr>
<tr>
<td>The Toolbars</td>
<td>The <em>toolbars</em> contain buttons for quick access to the more commonly used commands that are found on the menus.</td>
</tr>
<tr>
<td>The Status Bar</td>
<td>The status bar at the bottom of the window provides information about the current document.</td>
</tr>
<tr>
<td>The Working Area</td>
<td>The working area is the part of the application window where you input and manipulate information.</td>
</tr>
</tbody>
</table>

![Diagram of an application window with components labeled: Menu Bar, Toolbar, Working Area, Status Bar.](image)
The Accessories

The Accessories

The Accessories are a group of small programs (sometimes called *applets*) that are provided free with Windows. The most commonly used accessories are:

- Wordpad – a simple word processing program.
- Paint – a graphics program.
- The Calculator – performs calculations similar to a hand-held calculator.

To Use the Accessories

1. Click the **Start** button.
2. Move to **Programs**, then to **Accessories**.
3. Trace to and click on the application you want.
Exercise Working with WordPad

1. Go to Start, Programs and Accessories and open WordPad. Does a button for WordPad appear on the taskbar?
2. You will create a memo to your supervisor. Type the following then press the Enter key twice:
   
   Today’s date

3. Type the following then press the Enter key twice:
   
   To: Your Supervisor

4. Type the following then press the Enter key twice:
   
   From: Your Name

5. Type the following then press the Enter key twice:
   
   Subject: Budget

Leave WordPad open and go on to the next exercise.
Exercise Working with Calculator

1. Go to Start, Programs and Accessories and open the Calculator.
2. Use the Calculator program to add 10 plus 20. What did you get for an answer?
3. Use the Taskbar to go back to your memo that you started in WordPad. Is it still there?
4. Use the Taskbar to go back to Calculator and then close it.
Lesson Four: File Management

Objectives

At the end of this lesson, you will be familiar with:

- File Management Concepts
- Using My Computer
- Creating folders
- Saving Files
Most application files and document files are arranged in folders. These folders usually contain related items. This makes it easier to find the specific file you want. Folders can also contain subfolders which in turn can hold either more folders or files or both.

The folders are located on *drives*. The drives are the storage areas for your documents. The drives that your computer has act like *file cabinet drawers*. You can open these virtual drawers and put folders in them and then put your documents in the folders.

All computers have at least two drives, or in other words, two storage areas for your document files. These are called *3½ Floppy (A:)* and the *C: drive*. These two drives are in the computer on your desktop.

In most companies users also have access to a third drive, a “network” drive. This drive is located on the network computer (server). This drive can have almost any letter assigned to it. In this book, we call it the *N: drive*.

If you have access to three drives for saving your files, then you have the electronic equivalent of a 3-drawer filing cabinet.
The Virtual File Cabinet

Three drives are the virtual equivalent of three drawers.

Accessing Files

Folders and documents may be found, arranged, copied, deleted and so on using either My Computer or Windows Explorer. Each offers different advantages.
My Computer

Using My Computer

To start My Computer, find the icon on the Desktop and double-click it.

My Computer is one way to access everything about your computer: data files, program files, folders, drives and printers. Each item is viewed in a separate window.

The View

To see the contents of a drive or folder, double-click it and a new window will display the contents.

Within each window, the contents may be viewed in different ways:

- By large icons
- By small icons
- In a list
- With details

Click on the View menu and select the view you want.
To Create Folders

Files can be copied, moved, renamed or deleted in My Computer. You can also create *Folders* in which to store your files (documents).

To create a new folder:

1. Open the drive (double-click it) that you want to create the folder on.
2. Click on the **File** menu then **New** and **Folder**.
3. “New Folder” will be highlighted (blue). Immediately begin typing the name you want for the folder and press *Enter*. 
Exercise

1. Double-click the My Computer icon, then double-click the C: drive icon.
2. From the View menu, select List.
3. From the View menu, select Details.
4. From the View menu, select Large Icons.
5. From the File menu, select New then Folder.
6. Name the folder by typing *My Data* and press Enter.
7. Double-click *My Data* to open it and view the contents. (It will be empty.)
Saving a Document

You should save your documents often. The first time you save it, you must choose the folder in which to store it and give the document a name.

1. From the File menu, select Save or Save As (or Click the Save tool on the Standard Toolbar) and the Save As dialog box appears.

2. The top line of the dialog box (the Save in line) suggests a folder in which to store the file. If this is not what you want, you need to select a different drive and a folder. To do so, click on the drop-down button (the triangle) at the end of the Save in textbox.

3. From the list of drives, click on the one where you want to store your files. That drive name will appear on the Save in line and the folders on that drive will appear in the area beneath it.

4. Open (double-click) the folder that you want to store your file in. Now the folder name will appear on the Save in line indicating that it is open.

5. In the File name textbox at the bottom of the dialog box, type a name for the document.

6. Press Enter or click on Save.
Exercise Saving a Document

1. Return to the memo that you typed in WordPad. (It should still be on the Taskbar.)
2. From the File menu, select Save.
3. Click on the Save in: drop-down list. Open the C: drive and then the folder you created called *My Data*.
4. At the bottom of the dialog box, type *First Memo* in the File Name box.
5. Click Save (or press Enter).
6. Close the WordPad program.
<table>
<thead>
<tr>
<th>Computer Shut Down</th>
<th>1. Close all programs (click on the X in the right corner.)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2. When you are back at the Windows desktop (and there</td>
</tr>
<tr>
<td></td>
<td>are no buttons left on the Taskbar), click on the <em>Start</em></td>
</tr>
<tr>
<td></td>
<td>button and <em>Shut Down</em></td>
</tr>
<tr>
<td></td>
<td>3. Make sure that <em>Shut down</em> is selected and click on <em>OK.</em></td>
</tr>
<tr>
<td></td>
<td>4. Wait until a message appears that says it is safe to turn</td>
</tr>
<tr>
<td></td>
<td>off the computer, then do so.</td>
</tr>
</tbody>
</table>

![Shut Down Windows](image)